@ Basic TI-Nspire™ CX Functionality

Key Name Function

% Click Key Selects an object on the
screen.

(See Figures 1 and 2.) @ n grabs an

object on the screen.
Slide or Press the arrow

TouchPad keys to move the
cursor/pointer.
Removes menus or
Escape Key dialog boxes from the
screen.

Provides a temporary

Scratch Pad application ( i.e.

calculator)
Tab Key ?1'/[;1)(\1].68 to the next entry "
The Big Three Touchpad Cursor Controls
Home Key r]?lleslﬂays the home Figures 1 & 2
Document Key g?;lct:l?iz document
Menu Key g;féii]ini%ﬂicaﬁon or %

B) Graph

The Document Model
1. The TI-Nspire ™ handheld is “document based and

menu driven”. This simply means that everything you

do must be done in a document much like on a

computer, and the tools for every application can be

found in its menus. |

e  Turn on your TI-Nspire ™. If the screen shown in

Figure 3 is not displayed, press for Home.

Open a new document by selecting 1: New

Document and 1: Add Calculator to add a new

Calculator application page (Figure 4).

Figure 4

©2015 Texas Instruments Incorporated Page 1 west@geneseo.edu




@ Basic TI-Nspire™ CX Functionality

The Calculator Application
1. Page 1.1 is a calculator page. (Figure 4).

2. Perform the operations shown in Figures 6 to 13:

Note: To select a menu option, you can highlight the option and

press or . Alternately, you can press the number key for

that option. U

Figure 4(Again)
e To find the gcd of two numbers, press Menu, 9, 1: Actions L |
. . 52 Number  [1: Convert to Decimal
Number, Greatest Common Divisor. (Keystrokes: B A e F= | YA e o

. fe9 4: Calculus [3: Factor

@ E]) (Flgures 5 and 6) @ 5: Probability [4: Least Common Multiple
X 6: Statistics
[38] 7: Matrix & V/{6: Remainder

$€8: Finance |7: Fraction Tools »
[£3 9: Functions {8: Number Tools »
'—

9: Complex Number Tools  p

Figure 5
*Getting St..054 < )
gcd(lS 48) Radian [~
. . e . 3 ©
e To enter a fraction, type the division key or use the
lem(18,48) 144
fraction template by selecting @ E] (the right 12 7
S Z
2 3 6
side of the E] E] toggle. L L 16667
23
Figure 6
*Getting St.0S4 <  RaD{JI| B3
e  For an approximate value, press @ '
. 12 1.16667
(Figure7). PR
Note: To clear the calculator screen, press for Menu, Actions, 11 %
2+
Clear History (Keystrokes [1] @) L
2

Figure 7
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@ Basic TI-Nspire™ CX Functionality

e To convert a decimal to an approximate fraction *Getting St. 0S4
press Menu, Number, Approximate to Fraction.
(KCyStI‘OkCS. [Z][Z]) (Flgure 8) 0.375PapproxFraction(5.e-14) 3
8
0.33333PapproxFraction(5.£-14) 33333
100000
Figure 8

e To factor a number, press Menu, Number, Factor.

(Keystrokes: menu](2](3]). (Figure 9).

factor(240) e

999999999999999 2
999999999999998000000000000001

e To access square root command, press @ E] 999999999999999° Leso
f+ls s+
or press (the left side of the toggle, or G S

type sqrt(. (Figure 9).

Figure 9

999999999999999 2

fei{g
e To access the absolute value command, press R R R

% °

too | [38] | )

4 limo
Jpan | frma

(the left side of the toggle), and choose the

absolute value template or type abs(  (Figure 10).

Figure 10
e Toraise a number to a power, enter the base, press

*Getting Started <=

, and select the template shown in Figure 11.

Enter the power, and press [enter]. (Figure 12.)

id o RCIEE]
lof | oo (B8] | e

4a | 5 limo
& l‘.’dn ]udn 0*0

4 0/99

Figure 11
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@ Basic TI-Nspire™ CX Functionality

9999999999999992

9999999999999992
999999999999998000000000000001

10100
10000000000000000000000000000000000¢

100 @
A 10100

Figure 12

*Getting Started <=

e To access the degree symbol, press @ for the

symbols menu (Figure 13).

e Move the cursor to the right, and select the

° (degree) symbol and press .

e To access the factorial symbol, press Menu,

Probability, Factorial. (Keystrokes: [menu][4][1]) OR 100!
use the symbols menu described above. (Figure 14). P23202154430441520816992388562067009
log (2)+log (5) log (10)
3 3 3
log (2)+log (5) 2.0959
l v
Figure 14
) 933262154439441526816992388562667008
e To access the templates for matrices, press (the left
log (2)+log (5) log (10)
i mis | [ i i E i
side of the toggle). (Figure 15). iog ¥iog (5] 5 0950
[1 2H3 -1] [17 1]
46)|7 1 54 2 I
l v
Figure 15
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@ Basic TI-Nspire™ CX Functionality

e Define function f1(x)=x>. (Keystrokes: Press, , Seling SLON 2
select Define and type f1(x) = x”) OR simply type the | log_(2)+10g _(5) SRk
. 2
word Define followed by f1(x)=x". [1 2]_ [3 _1] [17 1]
46/|7 1 54 2
e Evaluate f1(-5) (Figure 16). Define £7(x)=x2 Done
f1(-5) 25 I
| e
Figure 16
The Graphs Application SE 1:Add Calculator
[ 2:Add Graphs
Basic Graphing N3:Add Geometry
= J4:Add Lists & Spreadsheet
115:Add Data & Statistics
Insert a New Page. e
47:Add Vernier DataQuest
e Add a new page. (Keystrokes: 4:Insert, 2: Page)
and then select Add Graphs (Figure 1).
Shortcuts: Press @ or Press %’t
The Graphs application is now page 1.2 of the document. — FlgureA |
Note: The graphing window shown is the default window setting O 7)< =
with a screen aspect ratio of one.
1. The function notation f2(x) is shown in the entry line. 1
X,
Explain why. (Figure 2). . : "
2. To see and graph f1(x), Press a and (Figure 3).
Note: The Entry line is now hidden. To recall the Entry Line, il

Press @@ Figure 2

Note: To edit a function, recall the Entry line and edit OR T K —

. . . . A
double “click” on the equation showing on the screen and edit. 6.671Y
f1(x)=x?
/
X
10 i 10
> -6.67
») 6.6 £
Figure 3
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@ Basic TI-Nspire™ CX Functionality

Modifying the Window
o  Method 1: Press Menu, Window, Window Settings
(Keystrokes: (4)(1)) and enter appropriate values

for xmax, xmin, etc. (Figure 4).

e  Method 2: Double “click” on the each of the end

values of the axes and edit appropriately.

Note: These methods will rescale the axes and may not maintain

the 1 to 1 aspect ratio.

Tracing a function

e  Press Menu, Trace, Graph Trace (Keystrokes:
(5](1]). Use the Touchpad to move the cursor
(spider) left or right to trace the function. Press or

to permanently fasten a point and its coordinates on
the graph. (Figure 5).

Note: The x or y coordinate of the point may be edited by double

“clicking” on the entry, typing in a new value and pressing

or . (Figures 6 and 7).

KERE indow Settings

XMin: |ﬂ

XMax: [10

XScale: I o]

YMin: [ -6 6666666666667

10

.):)4

YMax: |6.6666666666667

YScale: I Auto

411|128

Figure 4

*Getting Started <~

10

o

6.671 £ 1:186.3.46)

Y

Figure 5

*Getting Started <~

of]] ]

10

o

6.67

411|123

Figure 6

*Getting Started <=

{ieA

o

6.67

Figure 7
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@ Basic TI-Nspire™ CX Functionality

Actively Manipulating Functions 1] 1.2
6.67 %y
1. Use the Touchpad arrow keys to move the graph on the ‘ graph 1 [ (5 4)
screen. f1 I.rx:l=l’2
. : /
As you move the pointer close to the graph of a function, %
10 ! i0
one of two different types of cursors will appear.
®  The two-directional arrow stretches the function 7
> -6.67
(Figure 8). Notice the word graph also appears. Figure 8

®  The four-directional arrow translates the function

*Getting Started <~

(Figure 9).
2. Place the pointer near the graph until the two-directional (2,4)
£1(x)=x*
arrow appears. ol
/1 graph 1 "
3. Press @ , and use the Touchpad arrow keys to 10 i 10

stretch or translate the function.

5 6.67

Figure 9

*Getting Started

Moving Between Pages in a document

¥ Problem 1
1. Press @ « (on the TouchPad) to move back one page
2. To view all of the pages of the problem, press @ a (on N
the TouchPad) (Figure 10).
Note: This screen allows you to move from one page to another.
To open the page that you wish to view, highlight the page Figurel0
by moving left or right with the Touchpad .When the & o Fold
12: Rename -
appropriate page is highlighted, press . % 3 Save As... a| Size -
% 4 Qpen asK||
Note: To change the order of the pages, highlight the page by 5: Close (Cri+W) 21K
moving left or right with the Touchpad, and hold the - 7 Egpénd All 0K
2 8: Collapse All
until the hand closes. Then use the NavPad cursor ¢ or ) — 35 ettinpgs RSEE s 62E
move the page to the desired place, and press [enter]. kS B Refresh L [ &
C: IRelete All
[ Prob 9 fig 35K |4

Figure 11
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@ Basic TI-Nspire™ CX Functionality

Creating a New Folder

1. Press Home, My Documents. (Keystrokes: ).

2. Highlight the folder in which you would like to create
your new folder.

3. Press Menu, New Folder. (Keystrokes: (1)), type the
name of the new folder and press . (Figures 11 and
12).

Saving a Document

1. To save the current document, press , File, Save
(or Save As...) (Keystrokes: [docv], [1],(2])(Figure 1).

2. The Save As...: dialog box appears and will be
highlighted, enter your file name (Figure 2).

3. Recall that TI-Nspire behaves like a computer and that
the Touchpad behaves like a computer touchpad or a
mouse.
® If the folder, that you wish to save the file in is

highlighted, then press[enter].
® However, if the folder that is highlighted is not the

correct one, use the Touchpad to slide the cursor

to the correct folder press click followed by [enter].

Name a| Size
ey L
[ Potsdam PTE 221K
[ Restores 0K
[ Screen Captures 0K
(5 Stephen West Sessiond# 451 62K
[ West 624K
*[[] Getting Started 1K
[ Prob 9 fig 35K
Ty New Folder 1=

Figure 12

Documents

' 1.2 g *Getting Started <

i 1: New Document (Ctrl+N)
2:|2: Open Document (Ctrl+Q)
3:[3: Close (Ctrl+W)
ks 4 Save \
55 Save As...
65 <
-10 7

00

& 9: Press—to-Test

7: VieW copyright information
T

4

) -6.67
Figure 1
Save As... P
Save In:| My Documents I = =
Name Type Size
(757 Leadership 2010 Folder &
[ Logs Folder
&5 My New Folder Folder 1
| [ MyLib Folder ™
File Name: |Gerting Started |
A |

Figure 2

Note: Folders on TI-Nspire can be nested like those on a computer. Use the Touchpad to navigate the folders

much in the same way as on your computer.

4. To check to see if your document has been saved. Press for Home 2: My Documents.

The folder will appear showing the document that you have just saved.

r i
Shortcut: To save the current document, press @ for save

©2015 Texas Instruments Incorporated Page 8
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@ Basic TI-Nspire™ CX Functionality

Graphing in 3D

The 3D Graphing view lets you enter functions of the form z(x,y)
and view and explore them in three-dimensional space.

While you are in the 3D Graphing view, you can define, rotate,
resize, and trace 3D graphs. You can set the colors and other
visual attributes of a selected graph, and you can customize the
3D viewing environment.

1. Insert a New Page and select Add Graphs.
2. In the View Menu select 3D Graphing (Figure 1.)

3. In the entry line enter a function for example:
2 2

zZl(x,y) = x% and press Enter. (Figure 2).

Range Settings

The Range Settings function (Figure 3 and 4) in the same way as
in two dimensional graphing with the following exceptions:
e eye 0: Rotation in degrees around the z-axis clockwise
from positive x-axis
e eye 0: Rotation in degrees clockwise around a line
through the origin and parallel to the screen midline
e eye distance: the distance ( a number between 1 and 100)
from the viewing eye to the graph.

Rotating the 3D view
Press any of the four arrow keys to rotate the graph.

Note: A legend displaying orientation of the axes appears in the upper
right hand corner.

To rotate automatically:

e Auto rotation is equivalent to holding down the right
arrow key.

e From the Actions menu, select Auto Rotation. The Auto
Rotation icon appears, and the graph rotates.

e (Optional) Use the up and down arrow keys to explore
the rotating graph.

e To stop the rotation and return to the Pointer tool, press
ESC.

R 1: Actions

3y 2: View

5 3: 3D Graph Type Ok

pAC B P 1 Range Settings. ..

% S Trace;rz 2: Shrink Box (+ or<)

|@ 6: Hints|£2 3: Magnify Box (x or>)
It 4: x—y-z Orientation  (0)
L, 5t %~y Orientation @
i, 6: y—z Orientation 0

L3 i—z 7: x=z Qrientation )

)

>

Figure 3

8 3D Range Settings

ZMin: [ 5

>

ZMax: [s5

ZScale: | Rita

eye 8" [35

eye % [160

|
|
m
|

eye distance: |1 .8999999761581

I

‘>,>‘

Figure 4

©2015 Texas Instruments Incorporated Page 9
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@ Basic TI-Nspire™ CX Functionality

To view from specific orientations:

Press Z, Y, or X to view along the z, y, or x axis.

Press letter O to view from the default orientation.

Tracing in the 3D view

1.

From the Trace menu, select z Trace.

The z Trace icon and the trace plane appear, along with
a text line showing the current "z=" trace value. (Figure
5.)

To move the trace, hold down Shift and press the up or
down arrow key. The "z=" text is updated as you
move.(Figure 6.)

(Optional) Use the four arrow keys to rotate the view
and see how the trace plane and the graph intersect.

To stop tracing and return to the Pointer tool, press
ESC

To set custom plot colors:

Custom plot colors can make it easier to see the shape
characteristics of the graph. You can assign different colors to
its top and bottom surfaces or choose to have the graph colored
automatically, based on height or steepness. You can also set
the wire color.

1.

Display the graph’s context menu, and then select
Color > Custom Plot Color.

Select one of the three Surface color options:
Top/bottom color, Vary color by height, or Vary
color by steepness.

If you choose Top/bottom color, click the color
swatches to select colors for the top and bottom
surfaces.

If you choose to vary color by height or steepness,
colors are determined automatically. Figure 7.)

To set the Wire color, click the color swatch and select
a color

o

VAN
':\ )

“i‘\\\ |
I
{ i

Wi
i

Figure 7

©2015 Texas Instruments Incorporated
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@ Basic TI-Nspire™ CX Functionality

The List & Spreadsheet Application

1. Open a New Document and add a List & Spreadsheet page.

Move to the top of column A and label the column as
“xvalue”

Insert data {1,2,3,4,5} into cells A1-AS5.

Move to the top of column B and label the column as
“yvalue”

Insert data {5,7,9,11,13} into cells B1-B5. (Figure 1).

Note: The Lists and Spreadsheet application works much

like a computer spreadsheet.

2. Create a Scatter Plot.

Insert a Graphs page.

Press, Menu, Graph Type, Scatter Plot. (Keystrokes:
(menu](3](4)). (Figure 2).

Press , select “xvalue” as the input variable and
press . (Figure 3).

Press , w select “yvalue” as the output

variable.

Select an appropriate window to view the data. (Figure
4).

<« EER » *Unsaved < mﬂ
® * xvalue B yvalue |© D 'i‘
2 2 7
3 3 9
4 4 11
izl 5 13
6 |
56 [4]»]
Figure 1
‘EEEEREEY ‘cGetino St.054 rao 1169
O s1 {'\"‘l =
e
1
X
10 1 10
-6.67
Figure 2

O s1 {.\' «xvalue —

y «—yvalue|

-6.67

Figure 3

?xvalue,yvalue )

0.6 5%

Figure 4
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@ Basic TI-Nspire™ CX Functionality

3. Create a Quick Graph.
® Go back to Page 1.1

® Press the Touchpad a until the entire column A is

highlighted.
® Hold down and press the Touchpad ) to
highlight column B also.

® Press for Menu, Data, Quick Graph, (Keystrokes:

[menu](3](6]) then press (Figures 5 and 6).

The Data and Statistics Application

1. Create a Scatter Plot
¢ Insert a New Page and add a Data and Statistics

application. (Figure 7).
®  Move the cursor to the words “click to add variable” at

the bottom of the page and press on the rectangle.
® Use the Touchpad a to select “xvalue” as the input
variable and press . (Figure 8).
® Move the cursor to the left side of the page and press

when the words “Click to add variable” appear.

1333: Data »1: Generate Sequence |
X 4 Statistics p|f2: Data Capture 4
% 5: Table p|3: Fill

1 lear Data I

3 [

5: Random M—
i 4 6: List Math o
S 5 7: List Operations 4
6 | 8: Summary Plot

9:Q ap ~
B6 b

Figure 5

®xvalue [B yvalue i (0]
_ 1l

= 1 (6]

2 2 g

<] 3 g 9 O

4 4 11 { @

[ 6 =

= 5 13 l®

6 T T T

52 15 30 45
|55| | 4 | b xvalue
Figure 6

_lick to add variable

Caption: xvalue

@

3 @-

¥ 0>
4 .

s o © o

Click to add variable

Figure 7

10 1'5 2.0 2'5 3.0 3.5 40 45 50
xvalue

Figure 8

©2015 Texas Instruments Incorporated Page 12

west@geneseo.edu




@ Basic TI-Nspire™ CX Functionality

Use the Touchpad w to select “yvalue” as the output

variable and press . (Figure 9).

2. Add a Movable Line

Press Menu, Analyze, Add Movable Line. (Keystrokes:

[menu](4](2]). (Figure 10).

Move the cursor close to one end of the line and the CD

cursor will appear (Figure 11).

Grab the line and drag it until it “fits” the data. (Figure

12.)

Note: You may have to move the ¢J cursor from one

end of the line to the other end several times to

achieve a good approximation to the data.

1 @]
6 4
1 @
T T T T T T T T T
el e 2ile) 20 2ie) 2 i o) b il
xvalue
Figure 9

» *Getting St..054 — raD {71 PR

m2(x):=2.5 x+1.5

@)
T T T T T T T T T
(o) ) Palel 24 R o) 21 Gllel Gl e
xvalue
Figure 10
12
@
2
g
>
2(x):=1.97355 x+3.04127
6
T T T T T T T T T
140) a5 200) 205 2H0) 215 ALl dLE Ee)
xvalue
Figure 11
213132 0
1Pd
E
B
>
mZ(\'):=2'x+3
6
T T T T T T T T T
153202 54045 50
xvalue

Figure 12
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The Geometry Application

1. Start a new document, by pressing Home, New Document
(Keystrokes: E]). (Figure 1).
Note: If a Save option appears, select Yes or No
to save the document that was open when the
TI-Nspire™ handheld was last used.
2. Press (3] for 3:Add Geometry. (Figure 2).
Note: You could also press and select the
Geometry icon @ - this will add a Geometry

page to the currently open document.

Explore the Page

1. Use the Touchpad to explore moving around on the page.
(Figure 3).

2. Press , and look at the options in the following
submenus (Figure 4):
Menu 7:Points & Lines
Menu 8:Measurement
Menu 9:Shapes
Menu A:Construction
Menu B:Transformation

3. After pressing the p key to investigate submenu options in a
particular menu selection, press the key to exit that
list of menu options.

4. Press a second time to exit the Menu structure

entirely.

[

Figure 1

+21:Add Calculator

i 2:Add Graphs

N 3:Add Geomet

_|4 Add Lists & Sﬁreadsheet

1]5:Add Data & Statistics
6:Add Notes

A7 A AANS Avimine MmN ia o
5 FRtaivie] VCIIIICI vatavJucst I

Figure 2
] 1.1 L4 *Unsaved < {3
IZm
Figure 3
R 1: Actions
g 2 \/|ew
,:}.

To 4 Wlndowf Zoom

i 5 Trace

22 .
- 7 Pomts & Lme<f 2: Point On

: Measurement| > 3: Intersection Point(s)

9! Shapes —~—4&: Line

- A: Construction [.— 5: Segment

..» B: Transformatio|.— 6: Ray

—

o

—ﬁCHlnts 4 7: Tangent
- 8: Vector
(™ 9: Circle arc
Figure 4
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Investigation: Interior Angles of a Triangle
Draw a triangle, AABC.

1.

Choose the Triangle tool by pressing Menu, Shapes,
Triangle. (Keystrokes: (9](2]) (Figure 5).

Using the Touchpad, position the pointer to construct a
triangle near the center of the screen.
Press the or to place the first vertex on the
screen.

e One way to label vertices and points is to type the

label immediately after creating the point. Note:
The point will be flashing.

e For capital letters, press the key before
pressing the letter key (Figure 6).

Using the Touchpad again, move the cursor to a second

location for the next vertex.

Press or to place the second vertex.

Type the label immediately.

Repeat these steps to create a third non-collinear location
for the third vertex, and type its label.

Move away from the label, and press the key to
deselect the triangle tool.

e If you didn’t label one or more of the vertices
when constructing the triangle (as shown in Figure
7), you can label the vertex using the Text tool.

e Press for Menu, Actions, Text. (Keystrokes: |menu

Eg‘] Olcet\llsns d aved < ofl] <]
»
A3 » lcm
T4 Wlndow/Zoom )
£\, S Trace )
SE A ecinh
s Pomts & Llnes )
%8 Measurement  »
()9: Shapes (T Qrcle
_\- A: Construction A S
.= B: Transformation {7 3: Rectangle
@ C:Hints -7 4: Polygon
L 7 5: Regular Polygon

Figure 5

‘EBEENEER ‘Getino St-054

.
A

1com

Figure 6

Figure 7

32|33 |41

(1) (e)).

e Use the Touchpad to move close to the vertex.
e The vertex should blink. Be sure that the entire
triangle does not blink.

e Press or to open a text box.

(Figure 8).

bl 1 ;n

Figure 8

©2015 Texas Instruments Incorporated
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@ Basic TI-Nspire™ CX Functionality

mm PRI > *Getting St..054 < cec LI B3

1cm

e Press the appropriate letter key, and then press
to close the text box. B

e Pressthe key to deselect the Text tool.
(Figure 9).

Measuring the Three Interior Angles
1. Press Menu, Measurement, Angle. (Keystrokes: Figure 9

(8] [4)). (Figure 10). N T: Actions ,
PE’,‘, \/lew

2. Move the cursor with the Touchpad to select each A AL Zoom
vertex. A S Trace

33

\

7 Pomts & Lmes
Note: To select a vertex, use the Touchpad to move close to %8 Measurement

() 9: Shapes

a vertex. The cursor will indicate a point and its label. When | \-AiConstruction

.= B: Transformation

the “pencil” shape on the screen changes to a “hand” shape, |@ C:Hints

press or to select the vertex. (Figure 11).

v v v vl vwe vl

Figure 10
1 ; : . d 3. ) *Getting St..0S4 <
e The vertices must be selected in either a clockwise 321331+ o -
1cm
or counter-clockwise direction, just as angles are B
named.

Note: Regardless of direction, the vertex of the angle to

A
be measured must be selected second. Not only is the angle
€
drawn, but the angle being measured is marked.
Figure 11
3. After pressing or at the third vertex, the angle
value is located near the vertex of the measured angle. B
"68.2°
(Figure 12).
A
c
Figure 12
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4.
5.

Repeat to measure the other two angles (Figure 13).
If necessary, drag the measurements to an appropriate

location.

Note: You may wish to save your file before moving on.

Calculating the Sum of the Three Angles

For a calculation, an expression or statement of that

calculation must first be entered on the page.

1. Press for Menu, Actions, Text. (Keystrokes: (1] (6.

2. Position the pointer in an empty location on the screen.

3. Press or to open the text box (Figure 14).

4. Type the statement s = A + B + C on the screen using the
keypad, and press to close the text box (Figure 15).

Note:  You cannot put an equals sign at the end of this type of

statement, but you can start with a word or letter like ‘s’ as long as it
is not a reserved word like cos.

Press Menu, Actions, Calculate to select the Calculation
tool (Keystrokes: (1](8)).
Point at the statement s = A+ B + C. Press or to

select this calculation rule.

As you move away from the calculation rule, a box will
appear with a message asking for the first variable in the
calculation. In this example, the message is “Select a ? (or

press VAR)” (Figure 16).

o .4°

GI3CR off] < |

‘EBEENEEN ‘Getino St-054 oec 1) B9

1em

s=A=B+C

Figure 15

‘EBEENEER ‘Getingst-054  ces A
= B Lo
168.2°

h6.4°
35.3°

xpression s
s=A+B+<.e P

Figure 16
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Y d 3.2 RN > *Getting St..0S4 < oes {011 B3
8. Move near the first measurement.

peb B 1an
9. When a “hand” appears, select the angle measurement by Q8.2
pressing or (Figure 17).
10. When you move away from the first angle measurement, 6.0
the second variable value is requested. Gha®
11. Move to the second angle measurement and, when the sazpeg StecnrlrpressiAR
hand appears, select it by pressing or . Figure 17
12. Repeat this procedure to select the remaining angle ‘EBNEEIERN ‘etinost.054< ool

B ram

measurement. Agg 20

13. A sum will appear on the screen as you move away from
the last measurement selected. Drag the sum to a > .40
convenient location on the screen, and press to affix

it (Figure 18). s=A+B+C 180

Note: If desired, use the Text tool to label this numerical result Figure 18

‘s=". (Figure 19).

s=A+B+C
s=180
Figure 19
e Drag one or more of the vertices, and make a
Degree -
. . . B 2.
conjecture about the sum of the interior angles of a /1080 n
triangle. (Figure 20). Gavre
Does your conjecture hold for any type of triangle? Explain
our reasoning.
y £ s=A+B+C
25.6°
s=180
Figure 20
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@ Basic TI-Nspire™ CX Functionality

Measuring Objects
1. Insert a new Geometry page.

2. Draw a Quadrilateral, APORS.

Note: When using the polygon tool you must return to the initial

point (in this case P) and press or to complete your

polygon.
3. Measure the perimeter of the quadrilateral. Press Menu,
Measurement, Length, (Keystrokes: [menu](7](1]) and use

the Touchpad to move to a side of the polygon and press

[enter]. ( Figure 21).

Note: When you move the cursor to the polygon a text box reads
polygon PQRS and the measurement tool produces the
perimeter. If you wish to measure the length of a side of the
polygon you must select each of its endpoints.

4. Draw a circle and measure its circumference. (Figure 22).

The Interactive Notes Page Application

1. Open a New Document and add a Notes Page.
¢ An Interactive Notes Page can be used to take
notes, write directions, ask questions, or to interact

with other applications. The Format Menu can be

used to Bold Face, Italicize, Sybscript and

S ipt
Hpersetip entries. (Figure 1).

‘EENEEREEN ‘Getingst.0s4  ces{ER

R 1 am
polygon PQRS (@b

Figure 21

P *Getting St..0S4 —

Perimeter=42 cm

S

293 cm

Figure 22

A Notes Page can be used to take notes,
write directions, etc...

A Notes Page can be used to ask
questions...

A Notes Page can be used to interact with
other applications by inserting a Math Box.

The Format Menu can be used to Bold face,
ltalicize, Co OF subscript and P entries,

Figure 1
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@ Basic TI-Nspire™ CX Functionality

1211314
2. Insert a new Notes page. The Templates Menu can be used Question
to create a Question and Answer page or a Proof page. T ——
3 ?
(Figure 2 and 3). sl
Answer A
Figure 2
¢ m » *Unsaved < [ x|
3. Insert a new Notes page. This notes page will be used to F— o
interact with a Calculator Page and a Graphs page. Insert a W
Math Box by pressing Menu, Insert, Math Box il
. . Answer ¥
(Keystrokes menu], (3], [1]) and use this Math Box to define
None
g(x)=x". (Figures 4 and 5). : v
Figure 3
22: 1: Actions L.
24 2: Templates )
o 3:Insert g ath Bo t
4: Format ZA 2. Shape )
Math Box OptigfQ)]3: Comment
[= 6: Calculations Gl
@ 7: Hints |
Figure 4

Bl > *Unsaved <

Define g(x)=x2 + Done

{

Figure 5
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@ Basic TI-Nspire™ CX Functionality

4. Insert a new Calculator page. Evaluate g(3) and g(i).

(Figure 6).

5. Insert a new Graphs page. Graph f1(x) = g(x).

(Figure 7).

Using the Scratchpad

You may create and use a “temporary” Scratchpad to do

calculations or view a graph while in a document. To open a

Scratchpad:

1. Press Home,

e Press A: Calculate (Figures 8 and 9)

or

e Press B: Graph (Figure 10.)

Note: Shortcut Press

gl3) 97
glzl =1

Figure 6

141516
8.67Fy
1 [flxl=glx)
[.
%

10 ! 10
@ fix)=glx] 2/

Figure 7

f

3 Calculate

Fi gur
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@ Basic TI-Nspire™ CX Functionality

Scratchpad <

Saving the Scratchpad contents 7.39}

Y

You can save the Scratchpad Calculate page, the Scratchpad
Graph page, or both as a TI-Nspire™ document.

1. Press , then select Save to Document and press

2. The Save to Document dialog box opens.

Figure 1

3. Select the page or pages to save.

4. If a document is open, select either New or Current
document and press Save.

Note: If you selected to save to an open document, the Scratchpad pages are added to the document.

Clearing Scratchpad contents

To delete the calculations and/or graphing work from the Scratchpad application. Press , then select
Clear Scratchpad, and press .
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